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Logging In

Blackboard Learn X -+
< C @ https://bbprodapp.psuad.ac.ae
USERNAME
PASSWORD
Forgot Your Password?
Login ‘ ....................................................

The first step in using Sorbonne Blackboard Learn is to log in. Access
Sorbonne learn URL hittps://bbprodapp.psuad.ac.ae

QUICK STEPS: Logging In
1.In your browser, type or paste the URL.
2.Type your Username and Password.
3. Click Login.

@ Instructor Experience


https://bbprodapp.psuad.ac.ae/

Manage the Home Page

E

arth System Science

5 Mentars Available

more announcements. ..

more tasks. ..

My Tasks

My Tasks:

Earth System Science:

» Bigh up for group project

3:00 PM - 4:00 PM on 10/19/09:;
Guest Lecture

more calendar events...

%' Edit Motification Settings |

i
What's Past Due Actions ¥ |
¥ All Items {0} ¥
What's Due Actions ¥ |

A.Click Managél to edit the view of what appears in the module. For example, edit the
Announcements module view to include announcements for 7 days, 30 days, or all

announcements.

B.Click the “more” link in a fool module to be taken to a tool’s main page. For example, click the
“more tasks” link to be taken to the main Tasks page to set the status of the task.

C.Click Open in a New Window to view the module in a separate window. The window can be
moved to a different screen location. For example, keep the To Do module window open as you
navigate through the course.
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Exploring the My Institution Tab

* 8 Your Institution
UNIVERSITY

A. From the page header, go to

Hyinstiufion |G My Institution, your institution's
‘ My Institution ‘ Mofifications Dashboard home poge, HEIp, or |Og oui. O.I: .I.he
Personalize Page T sys’[em,
»d Announcements mo Institution Announcements have been Courses in which yvou are enrolled: B. My |nSfI|'U1'I0n TOb CO”eCT
S S (2 Eath Bystern Goience information from all courses you
. "J—G 4 Earth System Science Announcements: . . e
G tlew Grades ertore fvailablo * Mentors Available are enrolled in, giving you a total
s User Directo 3T EMMEMTEERIEE . [ Introduction to Qeeanodraphy (Materials Demo’ piCTure Of neWS Gnd OCTiViTy for
Information 11:00 AM - 12:00 PM on 9/17/09; My Tasks o
Jd I Entry v My Tasks: . . .
TSEL';;SFH%I_in?rEFfiDns for more specifics. Injtlllotluction to Oceanography (Materials C. TO SeleCT O COUFSG, C“Ck |TS hﬂe
. : is journal is public Demo): . I
T ors sandrevnts || | in the My Courses module.

D. Tools view announcements, course calendar events, tasks ,grades and Send email for all courses
in which you are enrolled.

E. Personal Information link 1o access and edit the personal information.
F. My Announcements — displays announcements for your courses.

G. My Calendar - displays calendar dates for your courses.
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The Course Environment

ﬁr-.n-:.- Flaces m Haome E Help i'p LogoLt
r Institution

UNIVERSITY A

hily Institution courses

Earth Sy=tem Science Home Page

=R=K s
Home Page (S

Home Page
Getting Started

My Announcements

Weel 1 Earth System Science
Discussions o * Mentars Available

Assignments

more announcements. ..
<
Groups
Toaols 12:00 PM - 10:00 PM on 9/17/09:
Web Sites Worksheet 1 due

A. Course Menu — the access point for all course content. Instructors decide which links are available
here.

B. Content frame - displays the selected tool or Content Area. By default, when you enter a course,
the Home Page appears.
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The Course Menu

B804 g

# Earth System S:iencei »

Home Page
Getting Started

Discussions
Zourse Blog <
Earth Science Web Sites

Groups

Tools

Identification Exercise 0
My Calendar G

Home Page

My Announcements

Earth System Science

* hMentars Availahle

My Tasks:

Earth System Science:

» Bign up for graup project

4
:
ki

Edit Matification Settings |

¥ Assignments {2)

Access all course content from the Course Menu. It
can contain links to the following:

A.Content Areas — top level containers that
organize and store course content, such as
lecture notes, assignments, and tests. In the
slide’s image, the Week 1 Content Area
contains items that will be used in a one week
period.

B. Individual tools — links to tools students will need
often, such as the Discussion Board and Blogs.

C.External links — Web sites used for an
assignment.

D.Course links — direct links to content also
available in a Content Area that you do not
want students to miss.

E. Module pages — customized pages that
contain modules, such as What's New, a
dictionary, a thesaurus, and My Calendar.
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Course Menu Views

Earth System Science Ho

Discussions

Course Blog
Earth Science Weh Sites

----- 4% Home Page

=-E5) Getting Started
[ Opinion Par...
[ Interestin...

------ [ Getting to ..

55 Wigek 1
- [ Study Guide

E'E Discussions

- Getting to .

----- T Identificat...

P wiater Coolar

Earth Svstd

Earth System Science:

» Bigh up for group project

What's New

Edit Matification Sefting
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About Edit Mode

# Earth Sysiem Assignments \

Science
Build Content LCERNCIE = RIS Discover Contant || T
Edit Mode is: m

i Worksheet 1
Sttached Files [ ¥Worksheet 1 (265 KE)

< Diowenload the attachrment, add your responses, and upload to this assignment with your Edrt MDdE‘ 15" [ ] DFF
last narne added to the file narme.

Home Page
Getting Started

Week 1

Assignments

CellER Bl This assignment is worth 25 points.

Earth Science Weh Sites

Groups The papertopic needs to have greater depth than the coverage the tapic receives in class.

!
!
!
!
!
I. Discussions
I.
!
!
!
!

<<<<(f<<<<<<<<<<$<<<<

I % Term Paper Requirements and Topic Submission

Tools
% J The paper needs to include the writer's owen conclusions and not be a repeat ofwhat is

As the Course Menu is created, you will work in Edit Mode. Edit Mode allows you to add and view
all the courses contents, even edit course menu .

A. Click Edit Mode to change from ON to OFF. When Edit Mode is ON, all instructor functions are
available. When Edit Mode is OFF, you see what students see.

B. When Edit Mode is ON, the Course Menu’s Add Menu Item function is available, which is shown as
a plus sign. Use this function to add links to the Course Menu. Whenever you add a new link to the
Course Menu, it will appear at the bottom of the list. You will learn how to reorder links later in this
workshop.
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Creating the Contents in your Course Content Areas Link

Ceutnsysiem scionce KR
=l o

# Earth System Scienceg *

Home Fage
Getting Started

_)

Weelk 1
Discussion
Course Blog
Earth Science Web Sites

Groups

Tools

3]

Week 1 Overvie
Althe end of this unit, you will be ahle to:

o Describe the rock cycle model
» Describe the sources of energy driving
« Differentiate between extrusive and int
s Listthe four classes ofigneous rock ir

o |dentify the most commoan rock found g

Week 1 Readings

Attached Files |1 Lecture and Readings (26.5 KB

Fleasze allow two to three hours to complete t

Identification Exercise

attached Files 1 \WWeek 1 Worksheet (265 KB

Week 1 Opinion

Each week you will weaigh in on a topic that pe
opinion. Feel free to respond toyour classma

Earth Science News

Spend some time explaring this weh site.

breadcrumibs

E—

A. On the Course Menu, click the name of the
Content Areq. The content appears in the
content frame.

B. In the content frame, click a link fo access its
content, such as a Discussion Board link or a file
link.

Breadcrumbs

As you view the items and links presented in a Content Areq, use the breadcrumios to navigate to
previous pages. In the following example, click the title of the course in the breadcrumbbs to return to
the course entry point, which is set by the instructor. In this course, it is the Home Page.

@ Creating Your Course Content



Determining the Content Organization

Three common approaches:

2| ] e # Introduction to Alte
: native Energy
# Earth System Science »

p— # Introduction to Home Page
Orme Fage Alternative Energy |
Getting Started Home Page Getting Started
Lectures Solar
Readings Wind
Assignments Biofuels

Organizing Content

Organizing Content
Areas by Subject

Area

Areas by Type of
Content

Organizing Content
Areas Chronologically
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Adding a Content Area

[ =

» Create Content Ares
» Create Tool Link

» Create Course Link
= Create External Link
1 » Create Module Page
» Create Subheader

= Create Divider

E| O & ﬂl I N
Add Content Area

¢ Bame: | Getting Started
Availahle to Users

cancel

4 :

1.In Edit Mode, point to the plus sign above the
Course Menu.

2. The Add Menu Item drop-down will appears.

3.Select Create Content Areq.

4.Type a Name for the new Content Area.

5.Select the Available to Users check box.

6. Click Submit.
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Adding Items and files to a Content Area

[ Week 1 *
Build Content Add Interactive Tool ¥ § Assign Textbook %% g

ltems, which can contain text, audio, movies, files, and images

Individual tool links

Individual audio, image, and video links

Folders, Content Area s, and Lesson Plans

Assignments, tests, and surveys
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Adding Items to a Content Area

7 Week 1

Build Content ¥ : 2 Ille
Create

ltem e
File

1.

Create Item

i Indicates a reguired field.

Attach File Browse by Computer E Browse Course Files

Content Information

# Name [Chapter 1 Study Guide |
Color of Mame . 2| Black o

Ted “izual Edlitar: m
“[Morma | [3%] [andl ¥ | B 7 Uabe| = £ |[===|i=i= =
cAs ¥y N[ & o QA JTALS | T OoOW

cEBEED RS BB

Download the attached doc to help you organize the materials for this chapter. Also find
some helpful studying hints other students have contributed owver the years.

“| Path: body

Attached files
File Name Link Title File Action

Chapter 1 Study Guide Create a link to this file

5 chapter!_study_guide.doc Do not attach

Options

Permit Users to View @ Yes (O No 6
this Content

Track Mumhber of
Wiews

O Yes & MNo

Select Date and Time ] Display Afler | | & |}
Restrictions [] Display Unti | IE] &

An item can contain text, audio, movies, files, images, and Mashups. If text is
added, it can be formatted using the Text Editor functions.

QUICK STEPS: Adding ltems to Content Areas

1.In Edit Mode, access the Content Area from the
Course Menu.

2.0n the Action Bar, point to Build Content to access
the drop-down list.

3.Select Item from the Create column.

4.0n the Create ltem page, type the item’s Name and
select a color for the name, if you want. Add optional
instructions or a description in the Text box. Format the
text using the Text Editor functions, if you want,

5.To add a file, click Browse My Computer or Browse
Course Files to locate the file. Add a Link Title for the
attached file; otherwise the file name appears in the
Content Area.

6. Under Options, select Yes for Permit Users to View this
Content to make the item available to students.

/. Click Submit.

@ Creating Your Course Content



Adding Items to a Content Area

7 Week 1

‘_

reate

3

ltermn

Create Item

Indicates a required field.

1.

Attach File Browse by Computer E Browse Course Files

Content Information

Mame [Chapter 1 Study Guide |
Color of Mame . Black o

Tex “izual Editor: m
“[Morma | [3%] [andl ¥ | B 7 Uabe| = £ |[===|i=i= =
~cabs ¥ N & oo PE AL | TEOO

cBEARE B

Download the attached doc to help you organize the materials for this chapter. Also find
some helpful studying hints other students have contributed owver the years.

“| Path: body

Attached files

Create a link to this file Do not attach

Chapter 1 Study Guide

5 chapter!_study_guide.doc

Options

Permit Users to View @ Yes (O No 6
this Content

Track Mumhber of
Wiews

O Yes & MNo

Select Date and Time 7] D|sp\ayAﬂer|
Restrictions [] Display Unt\l|

An item can contain text, audio, movies, files, images, and Mashups. If text is
added, it can be formatted using the Text Editor functions.

In the Build Content drop-down list, additional content types
are listed. Notice that Files, Audio, Image, Video, URL, and
Mashups are listed, but can also be added using the Text
Editor functions when adding a content item. The student
view may be different depending on the method used, so
experiment to determine which method meets your
needs.

NOTE: Under Attachments, the Browse Course Files function
takes you to a central storage location on the Blackboard
server that is accessed directly from the course. Instructors
can upload files to Course Files and link fo them when
creatfing course content. Within each course, Course Files
displays content for that specific course, not for other
courses taught by the instructor. Any file uploaded from your
local computer using the Browse My Computer function is
automatically added to Course Files. This repository is not
seen by students, but is available to instructors when adding
content or by accessing Files in the Control Panel. Course
Files is discussed in-depth in the manual, Using Course Files.
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Adding Items to a Content Area

Instructor view of a Content Area containing two items, each with a file
attached.

Edit Mode: m

[ Week 1 >
Build Content % Add Interactive Tool % | Assign Textbook ¥ [IEE

m = Reading Materials
— Atached Files j'_ﬁ Feading for Chapter 1 (26.5 KB)
Flease allow at [east three hours to fully understand this infarmation.
1 Chapter 1 Study Guide

Attached Files [ Chapter 1 Study Guide (26.5 KB)

Cownload the attached doc to help you organize the materials for this chapter. Also find some
helpful studyindg hints other students bave contributed over the years.

@ Creating Your Course Content



Editing the ltems in a Content Area

You can edit:

e The item’s name
e The item’s availability

e The order of the items

@ Creating Your Course Content



Editing the ltems in a Content Area

[ Week 1
! Chapter 1: The History of
Build Content 3% | Create Asses .I - Add Interactive Too Science
This chapter introduces you to
{ b B Reading Materials science, starting with the earlic
= attached Fies [ Reading x with our present ideas and tec|
» Edit
Flease allow at least thi History of Ocean Explorat
» Adaptive Helease &Q History o L7cean txploral
! Blog: Earth Scienc| * Adaptive Release: Advanced After reading and reviewing al
Click the link above to bq » Set Review StatusiDisabled) complete this assignment.
the instructions. This is o) e
» Btatistics Tracking (Onfo . inni
! [W2 Chapter1Study G g (On/Om ! Chapter 2: Beginnings of 1
— # User Progress . .
=| tached Fies [ Chapte In this chapter,‘ you will explor
(gL JEEE] L)y E e S Sy el

In Edit Mode, in the Content Areq, click the item’s Action
Link to access the contextual menu.

2 Select Edit.

1.Drag the item into the new location in
the Content Area. The item is
surrounded by dashes as it is being
moved into its new spot.

3 Edit the item’s Name or availability. If a content item
has been added, edit the actual content, if you want.

2.Release the item to place it in its new

Spot.
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The Keyboard Accessible Reordering Tool

Week 1

Build Content % Add Interactive Tool 3% | Assign Textbook %%

Reorder: Content

Week 1 Readings lterns

Week 1 Readings ~
[dentification Exercise

Week 1 Qpinion

IIll'.'llllE! B |-l. 1 |:| g r'lllli By

attached Files [ Lecture and Readings (26.5 KB)

Flease allow twio to three hours to comp

1 Identification Exercise
—= Attached Files [ Wveek 1 Worksheet (26.5 KB)

Cancel Subimit

QUICK STEPS: Using the Keyboard Accessible Reordering Tool

1.In Edit Mode, in the Content Areaq, click the Keyboard Accessible Reordering tool on
the Action Bar.

2.Click the item in the list to select it.

3. Use the up and down arrows below the title box to adjust the order.
4. Click Submit. A pop-up box states: Items have been reordered.

5. Click OK.
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_—
Building Your Syllabus R T

» Itermn » Content Fol
> File Blank Page
Audio Module Pag
» Image » Tools Area
QUICK STEPS: Adding Syllabus to Content Areas NAME - Video

© s
Offline Content

*  Syllabus Name

1. In Edit Mode, access the Content Area . - Leaming Module

2. On the Content Area 's Action Bar, point to Build ls'ji:f;:m e
Content and click Syllabus to add Course Syllabus.  syiiasus S

3. Add a Syllabus Name; type the Name. (4]

4. you can select Using Existing File Create New Syllabus @ Use Existing File

5. Browse My Computer, or Browse Course Files to frachile @) BroveeMyComputer | | prowse Coure
select your Syllabus File. 0

6. Click Submit. el
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Adding Files to your Contents

QUICK STEPS: Adding File to Content Areas

1. In Edit Mode, access the Content Area from
the Course Menu.

2. On the Action Bar, point to Build Content to
access the drop-down list Select File.

3.To add a file, click Browse My Computer or
Browse Course Files to locate the file.

4. Add a Link Title for the attached file; type the file’s
Name and select a color for the name, otherwise the
file name appears in the Content Area.

5. Select YES ,if you want to open the file with
new Window

6. Under Options, select Yes for Permit Users to
View this Content o make the item available to
students.

/. Click Submit.

Build Content % | Create Assessment %
Create Hew Page

* [tem = content Folder
» File e = Blank Page

W iy dic * hodule Page

Create File

* Indicates a required figld.

1.

¢ Find File Browse by Computer Browse Course Files
Selected File File Mame four systems.jpg

Select a Different File
* Mame

|FnurRocket Systems o

B Gsck

r“r‘esﬁ“Nne

Color of Mame

Qpen in Mew wWindow

A Standard Options

Fermit Users to View this & vas ¢ Mo

Content o
Track Mumber of Views

" Yes & No
Select Date and Time [ Display After | | | | &
Restrictions ) ' = =
[ Display Until | | | |©

(4]

@ Build Your Contents




Adding Folders to your Contents

QUICK STEPS: Adding Folder to Content Areas

1.In Edit Mode, access the Content Area .

2.0n the Content Area 's Action Bar, point to Build
Content and click Content Folder.

3.0n the Create Content Folder page, enter a Name.
The Name will appear in the Table of Contents in the
Content Area .

4.Enter text in the Text box. It is important to add @
description or other information here to that the
page does not appear blank when students access
it. Use formatting options to select font face, size,
alignment and color. Use the Text Editor to insert
Images, embed multimedia files and spell check.

5.Select the Options for availability, tracking, and date

and time restrictions.
6. Click Submit.

Space Exploration

Create Assessment %

Build Content %

1.

Create Content I'='older

1% Indicates a required field.

Create Hew Page
[term Cantent Folder 9
File Blank Page
hodula Plaos

Cancel

Content Feolder Information

* Name |Earl\,r Research

B = Black

Color of Mame

Text
“|Marmal =] |3 =] |arial - B 7 U =k | % x| =

CAEE YA N o v QO FALS I TOODOS
‘EREABE BE

“izual Editor: m:l

The earliest research into the development of rockets began with the development of projectile
weapons that used a propellant. o

“|Path: body = p

Fermit Users to View this & ves ¢ Mo

Content o
" Yes 0 Mo

r DisplayAﬂer|
[~ Display Unfil

Track Mumber of Wiews

Select Date and Time

|':.‘;L
Restrictions | C

."\:"\
|(=]

Cancel
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Adding URLs to Your Contents

QUICK STEPS: Adding URL to Content Areas

1. In Edit Mode, access the Content Area .

2. On the Content Area 's Action Bar, point to Build
Content and click URL.

3. On the Create URL page, enter a Name. The
name must be less than 255 characters long.

4. Enter the URL, including the protocol http://

5. Optionally, enter text in the Text box. Format the
text with the Text Editor, if desired

6. Optionally, add an attached file by clicking Browse
My Computer, or Browse Course Files.

/. Select the Options.
8. Click Submit.

Build Content % | Create Assessment %

Create Hew Page

» lterm » Content Folg
» File » Blank Page
s Audio * Module Fag
> Image » Tools Area

* Widen

@ Create UR

» LIRL e

* Offline Content

(M URL Informa

reguired fle
L parninn Modnle

tion

i'l'hlsm,gnh in exploration 3

[Fmpirweww. nas 3 govisploratonanesmosit o

Wisual Edbor

“[Nerma =] [33] [aid

N ]
"RED D

e rygse| s & | EER||SEREE
e oo GO F7TAF TS0 D
8 hE

b D

“This Manth in Exploration” rapons how avation and space exploration have changed throughout the

years, improving life for humans on Earth and in space

(5]

Browse My Computer Browse Course Files

Pemit Lisers o Viewthis & vas Mo

Open in New Window © Yes & Mo 0

Track Mumber ofViews = yas & Mo

& ™ Dizplay After | @ [

™ Display Usitil | B [

-

©
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Adding Multimedia to Your Contents

QUICK STEPS: Adding Multimedia to Content Areas Build Content ¥ | Create Assessment ¥
Create Hew Page
> It > G tFol
1 In Edit Mode, access the Content Area . e ontent Fo
> File » Blank Page
2 On the Content Area 's Action Bar, point to Build audio > Module Pag
Content and click Audio fo add recorded Audio. mage » Tools Area
3 On Content area Action Bar, point to Build um.

Content and click Image to add Image into your
content.

4 On Content area Action Bar, point to Build
Content and click Video to add Video into your
content.

5 In all Above Multimedia files, you can Browse My
Computer, or Browse Course Files to select your
media.

6 Optionally, enter text in the Text box. Format the
text with the Text Editor, if desired

/ Click Submit.
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Adding Mashups to a Content Area

QUICK STEPS: Adding Folder to Content Areas

1.In Edit Mode, access the Content Area .

2.0n the Content Area 's Action Bar, point to Build Content
and click the type of Mashup to add. For this activity, select
YouTube Video.

3.0n the Search for a YouTube Video page, enter a search
terms to locate a video, and click Go.

4.0n the Search Results page, the order of the videos is
determined by the YouTube Service so you may have to sort
the results or scroll down to find what you want. Click Preview
to watch the video before adding it to the Content Area .
Click Select to add the video to the Content Area .

5. Enter text in the Text box to describe the video or provide
any other information.

6.Select Mashup Options.

/. Optionally, attach or link other content.

8.Select the Options for availability, tracking, and date and
time restriction:s.

9. Click Submit.

e Tool 3¢ | Assign Textbook ¥

Mashups

Flickr Photo

SlideShare Presentation
YouTube Widen

Schaolar Strearm

Scholar Bookmark

Search Results

Search |Jupiter || Al of the words j|

Displaying 1 to 10 of 41811 iterms

Jupiter sounds (so strange!) NASA-Voyager r

Duration: (9:59)

User: hryzunik Added: 6507

YouTulre Rating: 4.753464 of 5 stars - 6206 Yotes View Coun
YouTulre URL: bt ftwenee youtube combwatch Pv=e3faE0] %™

Fram an ariginal CO: JUPITER MNASAVOYAGER SPACE 5
sounds (electromagnetic "voices") by MASA-YOvager. The

wind , planetary magnetosphere etc. create vibration "soul
compased of bydrogen and heliom. The entire planet is

P rewiew
Select
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- 'H'J'“"ul-"-r hﬂ'ﬂ'lul TALIVE bl
Build Content % | Create Assessment %

Adding Tests or Quizzes

» Test
¥ Survey
QUICK STEPS: Adding Folder to Content Areas b (w2 "“] > Assignment
— This N » galf and Peer po
Aszessment
1 In Edit Mode, access the Content Area . L —
2 On the Content Area 's Action Bar, point to Create Create Test

Assessment and click Test.

3 Select Create Test . In this example, we will create a test. 1
5 es
4 On The Add Tesi‘ p(]ge, elfher Creo.l.e O ﬂeW -I-eS-I- by Create a new Test or select an existing Test. Any Testthat has already been adde

. . . Create a Mew Test Create o
clicking Create, or select one from the Add Test list.

Add Test -- Select Test Below

5 Click Submit. Unit 3 Self Test

Unit 1 Test

6 The Test Options page will automatically appear after
the Test has been added to the Content Area . Select
the desired options, which conftrol instructions,
availability, feedback, and presentation. 2.

7 Clle subm"_ Click Subimit to add this Test, Click Cancel to guit
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Creating Announcements

QUICK STEPS: Adding Announcementisto Content Areas

1.0On the Control Panel, under Course Tools, select
Announcements.

2.0n the Announcements page, click Create
Announcement on the Action Bar.

3.0n the Create Announcement page, type the Subject
and an optional Message. Format the Message fext
using the Text Editor functions, if you want.

4.Under Web Announcement Options, select Permanent
or Date Restricted.

5.1f applicable, select the Display After and Display Until
check boxes and type the dates and times.
6.Optionally, under Course Link, click Browse to create
a link from the announcement to a course item. Select
the course item from the pop-up Course Map.

/.Click Submit.

:@ Announcements

= Files

Announcements

Blogs

@ Create Announcement

¢ Indicates a required field.

1.

Cancel

“ Course Tools o
Announcement Information
% Subject \Presentation Plans | [l ¥ Black
Message

‘lNu:urrnaI V||3 VHTimesNewRoman Vl B 7 U sk | % x°
cas A INE @& oo PO TAL VIO OO
“BELD RS B

Your Presentation Plans assignment iz due two weekis from today and is worth 50 points. Find
tnore instnictions i the hink to the Assignments Content Area.

Wizual Editar:

= i

“| Path: body
[] save as Reusable Chject

Web Announcement Options

Duration () Permanent
® Date Restricted

Select Date [] Display After[07/28/2009 | [E|[08:39 Pu | &
Restrictions [] Display Until 077302009 | [E]] [05:39 PM &
Override Liser

Motification Settings

Course Link 6

Click Browse to choosze an item.

Location |j4ssignmentsiPresents. Browse. .
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Thank You

Je vous remercile

Q SORBONNE
UNIVERSITE
ABU DHABI




